NSApplication

Inherits From: NSResponder : NSObject

Conforms To: NSCoding (NSResponder)
NSObject (NSObject)

Declared In: AppKit/NSApplication.h

AppKit/NSColorPanel.h
AppKit/NSDatal inkPanel.h
AppKit/NSHelpManager.h
AppKit/NSPagel ayout.h

Class at a Glance

Purpose
An NSApplication object manages an application’s main event loop in addition to resources used by all of that

application’s objects.

Principal Attributes

» Delegate * List of windows
« Key window * Main window

¢ DPS context

Creation

Project Builder

+ sharedApplication Creates the shared application instance (global variable NSApp).
Commonly Used Methods

— keyWindow Returns an NSWindow representing the key window.

— mainWindow Returns an NSWindow representing the main window.

— registerServicesMenuSendTypes:returnTypes: Specifies which services are valid for this application.
— runModalForWindow: Runs a modal event loop for the specified NSWindow.
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Class Description

The NSApplication class provides the central framework for your application’s execution. Every
application must have exactly one instance of NSApplication (or a subclass of NSApplication). Your
program’smain() function should create this instance by invokingstier edApplication class method.
After creating the NSApplication object, theain() function should load your application’s main nib file
and then start the event loop by sending the NSApplication object message. If you create an
Application project in Project Builder, thisain() function is created for you. Thmain() function that
Project Builder creates begins by calling a function naN@&lpplicationMain(), which is functionally
similar to the following:

voi d NSApplicati onMai n(int argc, char *argv[]) {
[ NSAppl i cation sharedApplication];
[ NSBundl e | oadNi bNanmed: @ nyMai n" owner : app] ;
[ NSApp run];

}

ThesharedApplication class method initializes the PostScript environment and connects your program to
the Window Server and the Display PostScript server. The NSApplication object maintains a list of all the
NSWindows that the application uses, so it can retrieve any of the application’s NSViews.
sharedApplication also initializes the global variable NSApp, which you use to retrieve the NSApplication
instanceshar edApplication only performs the initialization once; if you invoke it more than once, it

simply returns the NSApplication object that it created previously.

NSApplication’s main purpose is to receive events from the Window Server and distribute them to the
proper NSResponders. NSApp translates an event into an NSEvent object, then forwards the NSEvent to
the affected NSWindow object. All keyboard and mouse events go directly to the NSWindow associated
with the event. The only exception to this rule is if the Command key is pressed when a key-down event
occurs; in this case, every NSWindow has an opportunity to respond to the event. When an NSWindow
receives an NSEvent from NSApp, it distributes it to the objects in its view hierarchy.

The NSApplication class sets up autorelease pools (instances of the NSAutoreleasePool class) during
initialization and inside the event loop—specifically, withiniitg (or sharedApplication) andrun

methods. Similarly, the methods that the Application Kit adds to NSBundle employ autorelease pools
during the loading of nib files. These autorelease pools aren’t accessible outside the scope of the respective
NSApplication and NSBundle methods. Typically, an application creates objects either while the event loop
is running or by loading objects from nib files, so this usually isn't a problem. However, if you do need to
use OpenStep classes within thain() function itself (other than to load nib files or to instantiate
NSApplication), you should create an autorelease pool before using the classes and then release the pool
when you're done. For more information, see the NSAutoreleasePool class specificatiéroimead on
Framework Reference.

Subclassing NSApplication

Rarely do you need to create a custom NSApplication subclass. In general, a better design is to separate the
code that embodies your program’s functionality into a number of custom objects. Usually, those custom



objects are subclasses of NSObject. Methods defined in your custom objects can be invoked from a small
dispatcher object without being closely tied to NSApp. The only reason to subclassNSApplicationisif you

need to provide your own special response to messages that are routinely sent to NSApp. (Even then,

NSApp’s delegate is often given a chance to respond to such messages, so it's more appropriate to
implement the delegate methods.) To use a custom subclass of NSApplication, simply send
sharedApplication to your custom class rather than directly to NSApplication. If you create your
application in Project Builder, set the application class on the Project Attributes inspector, and Project
Builder will update thenain() function accordingly. As mentioned previously, NSApp uses autorelease
pools in itsinit andrun methods; if you override these methods, you'll need to create your own autorelease
pools.

The Delegate and Notifications

You can assign a delegate to NSApp. The delegate responds to certain messages on behalf of NSApp. Some
of these messages, suchapplication:openFile:, ask the delegate to open a file. Another message,
applicationShouldTerminate:, lets the delegate determine whether the application should be allowed to

quit. The NSApplication class sends these messages directly to its delegate.

NSApp also posts natifications to the application’s default notification center. Any object may register to
receive one or more of the notifications posted by NSApp by sending the message
addObserver : selector:name: object: to the default notification center (an instance of the
NSNotificationCenter class). NSApp’s delegate is automatically registered to receive these notifications if
itimplements certain delegate methods. For example, NSApp posts notifications when it is about to be done
launching the application and when it is done launching the application
(NSApplicationWillFinishLaunchingNotification and NSApplicationDidFinishLaunchingNaotification).

The delegate has an opportunity to respond to these notifications by implementing the methods
applicationWillFinishLaunching: andapplicationDidFinishLaunching:. If the delegate wants to be
informed of both events, it implements both methods. If it only needs to know when the application is
finished launching, it implements ordgpplicationDidFinishL aunching:. For more information on
notifications, see the NSNotificationCenter class specification ifrdbedation Framework Reference.

Method Types

Creating and initializing an NSApplication
+ sharedApplication
— finishLaunching

Changing the active application — activatelgnoringOtherApps:
—isActive
— deactivate
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Running the event loop —run
—isRunning
— stop:
— runModalForWindow:
— stopModal
— stopModalWithCode:
— abortModal
— beginModalSessionForWindow:
— runModalSession:
— endModalSession:
—sendEvent:

Getting, removing, and posting events
— currentEvent
— nextEventMatchingMask:untilDate:inMode:dequeue:
— discardEventsMatchingMask:beforeEvent:
— postEvent:atStart:

Managing windows — keyWindow
— mainWindow
— windowWithWindowNumber:
—windows
— makeWindowsPerform:inOrder:
— setWindowsNeedUpdate:
— updateWindows
— miniaturizeAll:
— preventWindowOrdering

Hiding all windows — hide:
—isHidden
— unhide:
— unhideWithoutActivation

Setting the application’s icon — setApplicationlconimage:
— applicationlconlmage

Getting the main menu — setMainMenu:
— mainMenu

Managing the Window menu — setWindowsMenu:
—windowsMenu
— arrangelnFront:
— addWindowsltem:title:filename:
— changeWindowsltem:title:filename:
— removeWindowsltem:
— updateWindowsltem:



Managing the Services menu — setServicesMenu:
— servicesMenu
— registerServicesMenuSendTypes:returnTypes:
—validRequestorForSendType:returnType:
— setServicesProvider:
— servicesProvider:

Showing standard panels — orderFrontColorPanel:
— orderFrontDataLinkPanel:
—runPagelLayout:
Displaying help — showHelp:

— activateContextHelpMode:

Sending action messages — sendAction:to:from:
— tryToPerform:with:
— targetForAction:

Getting the Display PostScript context

— context
Reporting an exception — reportException:
Terminating the application — terminate:
Assigning a delegate — setDelegate:

— delegate

Microsoft Windows specific methods
— applicationHandle
— windowWithWindowHandle:
+ setApplicationHandle:previousHandle:commandLine:show:
+ useRunningCopyOfApplication

Class Methods

\9 setApplicationHandle:previousHandle:commandLine:show:

+ (void)setApplicationHandle: (void *)hinstance
previousHandle: (void *) previnstance
commandLine:(NSString *mdLine
show: (int)cmdShow

On Microsoft Windows platforms, informs the NSApplication class of the values for the arguments passed
to theWinMain() function. This message should be sent once, as the first lineWfitiMdain() function.

If you create your application using Project Builder, this is done for you. You only need to invoke this
method if you implement your owtWinMain() function. Don’t override this method in NSApplication
subclasses.



Classes: NSApplication

This method is not implemented on the Mach platform.

See also: —applicationHandle

sharedApplication

+ (NSApplication *sharedApplication
Returns the NSApplication instance (the global NSApp), creating it if it doesn’t exist yet. This method also
makes a connection to the Window Server and completes other initialization. Your program should invoke
this method as one of the first statementaamn(); this is done for you if you create your application with

Project Builder. To retrieve the NSApplication instance after it has been created, you use the global variable
NSApp or invoke this method.

See also: —run, —terminate

\9 useRunningCopyOfApplication
+ (void)useRunningCopyOfApplication
On Microsoft Windows platforms, attempts to find an already running copy of the application at startup.
This method is invoked in th&¢/inM ain() function. If the command used to start the application contains

the option-NSUseRunningCopy Y ES and the application is already running, this method causes that
version of the application to be activated rather than start up a new copy.

The method returns if thé&lSUseRunningCopy Y ES option was not specified, if there was no previously
running copy, or if the running copy was unable to be used (for any reason). If a running copy is
successfully found and used, this method exits with a code of 0.

You never need to invoke this method directly. If you need to prevent the system from using an already
running copy of the application, write your oWwinMain() function, removing this method invocation.
NSApplication subclasses should not override this method.

This method is not defined for the Mach platform.

Instance Methods

abortModal
— (void)abortM odal
Aborts the event loop started bynM odalFor Window: by raising an NSAbortModalException, which is

caught byrunM odalForWindow:. Because this method raises an exception, it never returns;
runM odalFor Window:, when stopped with this method, returns NSRunAbortedRespabyse¢M odal



istypically sent by objects registered with the default NSRunL oop; for example, by objects that have
registered a method to be repeatedly invoked by the NSRunL oop through the use of an NSTimer object.

This method can also abort amodal session created by beginM odal SessionFor Window:, provided the
loop that runs the modal session (by invoking runModal Session:) catches NSAbortM odal Exception.

See also: —endModalSession:, —stopModal, —stopM odalWithCode:

activateContextHelpMode:
— (void)activateContextHel pM ode: (id)sender

Places the application in context-sensitive help mode. In this mode, the cursor becomes a question mark,
and help appears for any user interface item that the user clicks. This method is typically invoked on
Microsoft Windows platforms when the user selects the What's This menu item. (An application also enters
context-sensitive help mode on Microsoft Windows platforms when the user presses Shift-F1.)

On Mach platforms, most applications don’t use this method. Instead, applications enter context-sensitive
mode when the user presses the Help key. On either platform, applications exit context-sensitive help mode
upon the first event after a help window is displayed.

See also: —showHelp:

activatelgnoringOtherApps:
— (void)activatel gnoringOther Apps: (BOOL)flag

Makes the receiver the active applicatiorfldfy is NO, the application is activated only if no other
application is currently active. ffag is YES, the application activates regardless.

On Mach platformsflag is normally set to NO. When the Workspace Manager launches an application,
using a value of NO fdtag allows the application to become active if the user waits for it to launch, but
the application remains unobtrusive if the user activates another application. Regardless of the setting of
flag, there may be a time lag before the application activates; you should not assume that the application
will be active immediately after sending this message.

On Microsoft Windows platformdlag is normally set to YES. Settirftag to NO has no effect.

You rarely need to invoke this method. Under most circumstances, the Application Kit takes care of proper
activation. However, you might find this method useful if you implement your own methods for
interapplication communication.

You don't need to send this message to make one of the application’s NSWindows key. When you send a
makeK eyWindow message to an NSWindow, you simply ensure that the NSWindow will be the key
window when the application is active.

See also: —deactivate, —iSActive
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addWindowsltem:title:filename:

— (void)addWindowsl tem: (NSWindow *)aWindow
title: (NSString *)aString
filename: (BOOL)isFilename

Adds an item to the Window menu @Aindow. If isFilenameis NO,aString appears literally in the menu.

If isFilenameis YES,aString is assumed to be a converted path name with the name of the file preceding
the path (the way NSWindow&et TitleWithRepresentedFilename: method shows a title). If an item for
aWindow already exists in the Window menu, this method has no effect. You rarely invoke this method
because an item is placed in the Window menu for you whenever an NSWindow’s title is set.

See also: —changeWindowsltem:title:filename:, —setTitle: (NSWindow),
— st TitlewithRepresentedFilename: (NSWindow)

applicationHandle
- (void *)applicationHandle

On Microsoft Windows platforms, returns the application’s Win32 instance handle, which is a required
parameter for some Win32 function calls. This method is not defined for the Mach platform.

See also: + setApplicationHandle:previousHandle:commandLine: show:

applicationlconlmage
— (NSImage *applicationl conlmage

Returns the NSImage used for the application’s icon, which represents the application in the Workspace
Manager on Mach platforms or in the Program Manager on Microsoft Windows platforms.

See also: — setApplicationl conl mage:

arrangelnFront:
— (void)arrangel nFront: (id)sender

Arranges all of the windows listed in the Window menu in front of all other windows. Windows associated
with the application but not listed in the Window menu are not ordered to the front.

See also: —addWindowltem:title:filename:, —removeWindowsltem:,
—makeKeyAndOrder Front: (NSWindow)



beginModalSessionForWindow:
— (NSModalSessioteginM odal SessionFor Window: (NSWindow *)awindow
Sets up a modal session with the NSWin@Window and returns an NSModalSession structure

representing the session. In a modal session, the application receives mouse events only if they occur in
aWindow. The NSWindow is made key and ordered to the front.

beginM odal SessionFor Window: only sets up the modal session. To actually run the session, use
runM odal Session:. beginM odal SessionFor Window: should be balanced lepdM odal Session:. If an
exception is raisedieginM odal SessionFor Window: arranges for proper cleanup. Dat use
NS_DURING constructs to send amdM odal Session: message in the event of an exception.

A loop using these methods is similar to a modal event loop rurr witil odal For Window:, except that
the application can continue processing between method invocations.

changeWindowsltem:title:filename:

— (void)changeWindowsl tem: (NSWindow *)aWindow title:(NSString *aString
filename: (BOOL)isFilename

Changes the item f@Window in the Window menu taString. If aWwindow doesn’t have an item in the
Window menu, this method adds the itenisHilename is NO,aString appears literally in the menu. If
isFilename is YES,aString is assumed to be a converted path name with the file’s name preceding the path
(the way NSWindow'set TitleWithRepresentedFilename: places a title).

Seealso: —addWindowsltem:title:filename:, —removeWindowsltem:, —setTitle: (NSWindow),
— s TitlewWithRepr esentedFilename: (NSWindow)

context
— (NSDPSContext gontext

Returns the receiver’s Display PostScript context.

currentEvent
— (NSEvent *furrentEvent

Returns the current event, the last event the receiver retrieved from the event queue. NSApp receives events
and forwards the current event to the affected NSWindow object, which then distributes it to the objects in
its view hierarchy.

See also: —discardEventsM atchingM ask:beforeEvent:, —postEvent:atStart:, —sendEvent:
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deactivate
— (void)deactivate

Deactivates the application. Normally, you shouldn’t invoke this method; the Application Kit is responsible
for proper deactivation.

See also: —activatelgnoringOther Apps.

delegate
— (id)delegate
Returns the receiver’s delegate.

See also: —setDelegate:

discardEventsMatchingMask:beforeEvent:
— (void)discar dEventsM atchingM ask: (unsigned intnask befor eEvent: (NSEvent *JastEvent

Removes from the event queue all events matching those specifieskithat were generated before
lastEvent. Typically, you send this message to an NSWindow rather than to NSApp.

10



mask can contain these constants:
NSLeftMouseDownMask  The left mouse button was pressed.
NSL eftM ouseUpMask The left mouse button was released.
NSRightMouseDownMask The right mouse button was pressed.
NSRightMouseUpMask The right mouse button was rel eased.
NSMouseMovedM ask The user moved the mouse.
NSL eftMouseDraggedMask The user moved the mouse while the left button was pressed.
NSRightM ouseDraggedM ask T he user moved the mouse while the right button was pressed.
NSM ouseEnteredM ask The mouse entered a tracking rectangle.

NSM ouseExitedM ask The mouse exited atracking rectangle.

NSKeyDownMask A key on the keyboard was pressed.

NSKeyUpMask A key on the keyboard was rel eased.

NSFl agsChangedMask A Shift, Command, Alternate, or Escape key was pressed or released.
NSPeriodicMask A periodic event occurred.

NSCursorUpdateM ask Cursor update.

NSAnyEventMask Any event.

Use this method to ignore certain events that occurred after a particular event. For example, suppose your
application has atracking loop that you exit when the user rel eases the mouse button, and you want to
discard al of the events that occurred during that loop. Y ou use NSAnyEvent as the mask argument and
pass the mouse up event as the lastEvent argument. Passing the mouse-up event as lastEvent ensures that
any events that might have occurred after the mouse-up event (that is, that appear in the queue after the
mouse-up event) don't get discarded.

See also: —nextEventMatchingM ask:untilDate:inM ode:dequeue:

encodeWithCoder:

@protocol NSCoding
— (void)encodeWithCoder: (NSCoder *aCoder

Raises an NSinvalidArgumentException. You cannot encode an NSApplication instance.

See also: —initWithCoder:

11
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endModalSession:
— (void)endM odal Session: (NSModalSessiomgession

Finishes a modal session. The argunsesdion should be the return value from a previous invocation of
beginM odal SessionFor Window:.

See also; —runM odalSession:

finishLaunching

— (void)finishLaunching
Activates the application, opens any files specified by the “NSOpen” user default, and unhighlights the
application’s icon. Theun method invokeghis method before it starts the event loop. When this method
begins, it posts an NSApplicationWillFinishLaunchingNotification to the default notification center. When

it successfully completes, it posts an NSApplicationDidFinishLaunchingNotification. If you override
finishLaunching, the subclass method should invoke the superclass method.

See also: —applicationWillFinishLaunching: (delegate method),
—applicationDidFinishLaunching: (delegate method)

hide:
— (void)hide: (id)sender

Hides all the application’s windows. This method is usually invoked when the user chooses Hide in the
application’s main menu. When this method begins, it posts an NSApplicationWillHideNotification to the
default notification center. When it completes successfully, it posts an NSApplicationDidHideNotification.

See also: —applicationDidHide: (delegate method),applicationWillHide: (delegate method),
—miniaturizeAll:, —unhide:, —unhideéWithoutActivation

initWithCoder:

@protocol NSCoding
— (id)initWithCoder : (NSCoder *aDecoder

Raises an NSInvalidArgumentException. You cannot encode an NSApplication instance.

See also: —encodeWithCoder:



isActive
— (BOOL)isActive
Returns YES if this is the active application, NO otherwise.

See also: —activatelgnoringOther Apps., —deactivate

isHidden
— (BOOL)isHidden
Returns YES if the application is hidden, NO otherwise.

See also;: —hide;, —unhide:;, —unhideWithoutActivation

iIsSRunning
— (BOOL)isRunning
Returns YES if the main event loop is running, NO otherwise. NO meas®thenethod was invoked.

See also: —run, —terminate

keyWindow
— (NSWindow *keyWindow

Returns the key window, the NSWindow that receives keyboard events. If there is no key window or if the
key window belongs to another application, this method retuifns

See also: —mainWindow, —isKeyWindow (NSWindow)

mainMenu
— (NSMenu *mainMenu

Returns the application’s main menu.

See also: —setMainMenu:

13
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mainWindow
— (NSWindow *mainWindow

Returns the main window. If there is no main window, if the main window belongs to another application,
or if the application is hidden, this method retunils

See also: —keyWindow, —isMainWindow (NSWindow)

makeWindowsPerform:inOrder:
— (NSWindow *)makeWindowsPer form: (SEL)aSelector inOrder:(BOOL)flag

Sends thaSd ector message to each NSWindow in the application in turn until one of them returns a value
other thamil. Returns that NSWindow, aiil if all of the NSWindows returnewil for aSelector.

If flag is YES, the NSWindows receive th€elector message in the front-to-back order in which they
appear in the Window Server’s window listfldg is NO, NSWindows receive the message in the order
they appear in NSApp’s window list. This order is unspecified.

The method designated b§elector can’t take any arguments.

See also: —sendAction:to:from:, —tryToPerform:with:, —windows

miniaturizeAll:
— (void)miniaturizeAll:(id)sender
Miniaturizes all the receiver’s windows.

See also;: —hide

nextEventMatchingMask:untilDate:inMode:dequeue:

— (NSEvent *nextEventM atchingM ask: (unsigned intijnask
untilDate:(NSDate *expiration
inMode: (NSString *ymode
dequeue: (BOOL)flag

Returns the next event matchimgsk, or nil if no such event is found before thgiration date. Ifflag is
YES, the event is removed from the queue. See the method description for
discardEventsM atchingM ask: befor eEvent: for a list of the possible values fanask.



The mode argument names an NSRunL oop maode that determines what other ports are listened to and what
timers may fire while NSApp iswaiting for the event. The possible modes availablein the Application Kit
are:

NSDefaultRunLoopMode Main event loop.

NSEventTrackingRunLoopModeM odal event loops.

NSM odal Panel RunL oopM odeloops that operate while a modal panel is up.

NSConnectionReplyMode Loops that operate while NSConnection is waiting for reply.
Eventsthat are skipped are left in the queue.

Y ou can use this method to short circuit normal event dispatching and get your own events. For example,

you may want to do this in response to a mouse-down event in order to track the mouse while it's down. In
this case, you would setask to accept mouse-dragged or mouse-up events and use the
NSEventTrackingRunLoopMode.

See also: —postEvent:atStart:, —run, —runM odalForWindow:

orderFrontColorPanel:
— (void)or der FrontColor Panel:(id)sender

Brings up the color panel, an instance of NSColorPanel. If the NSColorPanel does not exist yet, it creates
one. This method is typically invoked when the user chooses Colors from a menu.

orderFrontDataLinkPanel:
— (void)order FrontDatal ink Panel: (id)sender

Brings up the data link panel, an instance of NSDataLinkPanel. If the NSDataLinkPanel does not exist yet,
it creates one. This method is typically invoked when the user chooses an appropriate command from the
application’s menu. For example, the Edit application invokes this method when the user chooses Link
Inspector from the Link menu.

postEvent:atStart:
— (void)postEvent: (NSEvent *anEvent atStart: (BOOL)flag

AddsanEvent to the application’s event queueflHg is YES, the event is added to the front of the queue,
otherwise the event is added to the back of the queue.

See also;: —currentEvent, —sendEvent:
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preventWindowOrdering
— (void)preventWindowOrdering

Suppresses the usual window ordering in handling the most recent mouse-down event. This method is only
useful for mouse-down events when you want to prevent the window that receives the event from being
ordered to the front.

registerServicesMenuSendTypes:returnTypes:

— (void)register ServicesM enuSendTypes. (NSArray *)sendTypes
returnTypes: (NSArray *)returnTypes

Registers the pasteboard types that the application can send and receive in response to service requests. If
the application has a Services menu, a menu item is added for each service provider that can accept one of
the specifiedendTypes or return one of the specifiedurnTypes. You should typically invoke this method

at application start-up time or when an object that can use services is created. You can invoke it more than
once; its purpose is to ensure that there is a menu item for every service that the application may use. The
event-handling mechanism will dynamically enable the individual items to indicate which services are
currently appropriate. All of the NSResponders in your application (typically NSViews) should register

every possible type that they can send and receive by sending this message to NSApp.

See also: —validRequestor For SendTypereturnType:,
—readSelectionFromPasteboard: (NSServicesRequests protocol),
—writeSelectionToPasteboar d:types. (NSServicesRequests protocol)

removeWindowsltem:
— (void)removeWindowsl tem: (NSWindow *)aWindow

Removes the Window menu item ffindow. This method doesn’t prevent the item from being
automatically added again. Use NSWindosésExcludedFromWindowsM enu: method if you want the
item to remain excluded from the Window menu.

See also: —addWindowsltem:titlefilename:, —changeWindowsl tem:title:filename:

reportException:
— (void)reportException: (NSException *anException

LogsanException by callingNSL og(). This method does not raise the exception. Use it inside of an
exception handler to record that the exception occurred.



run
— (void)run

Starts the main event loop. The loop continues ustib@ or terminate: message is received. Upon each
iteration through the loop, the next available event from the Window Server is stored and is then dispatched
by sending the event to NSApp ussandEvent:.

Send aun message as the last statement fnoamn(), after the application’s objects have been initialized.

See also: —applicationDidFinishLaunching: (delegate method), ~inM odalFor Window:,
—runM odal Session:

runModalForWindow:
— (int)runM odal For Window: (NSWindow *)aWindow

Starts a modal event loop favwvindow. Until the loop is broken by siopM odal, stopM odalWithCode:,

or abortM odal message, the application won't respond to any mouse, keyboard, or window-close events
unless they’re associated watindow. If sscopM odalWithCode: is used to stop the modal event loop, this
method returns the argument passestidpM odalWithCode:. If stopM odal is used, it returns the constant
NSRunStoppedResponsealfortModal is used, it returns the constant NSRunAbortedResponse. This
method is functionally similar to the following:

NSMbdal Sessi on session = [ NSApp begi nMbdal Sessi onf or W ndow: t heW ndowj ;

for (;5) {
i f ([ NSApp runhMbdal Sessi on: sessi on] != NSRunConti nuesResponse)
br eak;

}
[ NSApp endMbdal Sessi on: sessi on] ;

See also; —run, —runModal Session:

runModalSession:
— (int)runM odal Session: (NSModalSessiomgession

Runs a modal session representeddssion, as defined in a previous invocation of

beginM odal SessionFor Window:. A loop using this method is similar to a modal event loop run with
runModalForWindow:, except that with this method the application can continue processing between
method invocations. When you invoke this method, events for the NSWindow of this session are dispatched
as normal; this method returns when there are no more events. You must invoke this method frequently
enough that the window remains responsive to events.

If the modal session was not stopped, this method returns NSRunContinuesResgtomd ollal was
invoked as the result of event processing, NSRunStoppedResponse is retstopi dtlalWithCode:
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was invoked, this method returns the value passed to stopM odalWithCode:. The
NSAbortModalException raised by abortM odal isn’t caught, s@abortM odal will not stop the loop.

See also: —endModalSession, —run

runPagelLayout:
— (void)runPagel ayout: (id)sender

Displays the application’s page layout panel, an instance of NSPagelLayout. If the NSPageLayout instance
does not exist, it creates one. This method is typically invoked when the user selects Page Layout from the
application’s menu.

sendAction:to:from:
— (BOOL)sendAction: (SEL)anAction to:(id)aTarget from: (id)sender

Sends the messagpAction to aTarget. If aTarget isnil, NSApp looks for an object that can respond to

the message—that is, an object that implements a method maaohittpn. It begins with the first

responder of the key window. If the first responder can’t respond, it tries the first responder’s next responder
and continues following next responder links up the responder chain. If none of the objects in the key
window’s responder chain can handle the message, NSApp attempts to send the message to the key
window’s delegate.

If the delegate doesn’t respond and the main window is different from the key window, NSApp begins again
with the first responder in the main window. If objects in the main window can'’t respond, NSApp attempts
to send the message to the main window’s delegate. If still no object has responded, NSApp tries to handle
the message itself. If NSApp can’t respond, it attempts to send the message to its own delegate.

Returns YES if the action is successfully sent; otherwise returns NO.

See also: —targetForAction:, —tryToPerfor m:with:, —makeWindowsPer form:inOrder:

sendEvent:
— (void)sendEvent: (NSEvent *anEvent

DispatchesnEvent to other objects. You rarely invokendEvent: directly although you might want to
override this method to perform some action on every essrdEvent: messages are sent from the main
event loop (theun method) sendEvent: is the method that dispatches events to the appropriate
responders; NSApp handles application events, the NSWindow indicated in the event record handles
window related events, and mouse and key events are forwarded to the appropriate NSWindow for further
dispatching.

See also: —currentEvent, —postEvent:atStart:



servicesMenu
— (NSMenu *pervicesM enu

Returns the Services menurat if no Services menu has been created.
See also: —SetServicesMenu:

servicesProvider
— (NSMenu *}pervicesProvider

Returns the object that provides the services that this application advertises in the Services menu of other
applications.

See also;: —setServicesProvider:

setApplicationlconlmage:
— (void)setApplicationl conl mage: (NSImage *anlmage
Sets the application’s icon &mlmage.

See also: —applicationl conl mage

setDelegate:
— (void)setDelegate: (id)anObject

MakesanObject the receiver’s delegate. The messages that a delegate can expect to receive are listed at the
end of this specification. The delegate doesn’t need to implement all the methods.

See also: —delegate

setMainMenu:
— (void)setM ainM enu: (NSMenu *aMenu

MakesaMenu the application’s main menu.

See also; —mainMenu
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setServicesMenu:
— (void)set ServicesM enu: (NSMenu *aMenu

MakesaMenu the application’s Services menu.

See also: —ServicesM enu

setServicesProvider:
— (void)set ServicesProvider : (id)aProvider

Registers the objeaProvider as the service provider. The service provider is an object that performs all
of the services that the application provides to other applications. When another application requests a
service from the receiver, it sends the service requestrtwider.

For more information on registering services, see the on-line document
/NextLibrary/Documentation/NextDev/TasksAndConcepts/ProgrammingT opics/Services.rif.

See also; —servicesProvider

setWindowsMenu:
— (void)setWindowsM enu: (NSMenu *aMenu

MakesaMenu the application’s Window menu.

See also; —windowsMenu

setWindowsNeedUpdate:
— (void)setWindowsNeedUpdate: (BOOL)flag

Sets whether the application’s windows need updating when the application has finished processing the
current event. This method is especially useful for making sure menus are updated to reflect changes not
initiated by user actions, such as messages received from remote objects.

Seealso: —updateWindows

showHelp:
— (void)showHelp: (id)sender

Brings up the application’s help file by sending a request to the shared NSWorkspace object to open the file
using the default application for the help file’s type. (You set the application’s help file using Project



Builder.) This method istypically invoked when the user chooses the Help command or one of the
commands from the Help menu.

On Microsoft Windows platforms, the help fileistypically an HLPfile, so this method brings up Microsoft
Windows help. On Mach platforms, the help file istypicaly an RTF file and is displayed using Edit, but
the help file can be anything. For example, Project Builder on Mach bringsup aDigital Librarian bookshelf
in response to its Help command.

For more information on providing on-line help for your application, see the NSHelpManager class
specification.

See also: —activateContextHelpM ode:

stop:
— (void)stop: (id)sender

Stops the main event loop. This method will break the flow of control out ofithenethod, thereby
returning to thamain() function. A subsequentin message will restart the loop.

If this method is invoked during a modal event loop, it will break that loop but not the main event loop.

See also; —runM odalForWindow:, —runModalSession:, —ter minate

stopModal

— (void)stopM odal
Stops a modal event loop. This method should always be paired with a previous invocation of
runModalFor Window: or beginM odal SessionFor Window:. WhenrunM odalFor Window: is stopped
with this method, it returns NSRunStoppedResponse. This method will stop the loop only if it's executed
by code responding to an event. If you need to stami odal For Window: loop from a method

registered with the current NSRunLoop (for example, a method repeatedly invoked by an NSTimer object),
use theabortModal method.

See also: —runModalSession:, —stopM odalWithCode:

stopModalWithCode:
— (void)stopM odalWithCode: (int)returnCode

Like stopM odal, except the argumentturnCode allows you to specify the value that
runModalFor Window: will return.

See also; —abortM odal
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targetForAction:
— (id)tar getFor Action: (SEL)aSelector

Returns the object that receives the action meszaajector.

See also: —sendAction:to:from:, —tryToPerform:with:

terminate:

— (void)ter minate; (id)sender
Terminates the application. This method is typically invoked when the user chooses Quit or Exit from the
application’s menu. Each usetef minate: invokesapplicationShouldTer minate: to notify the delegate
that the application will terminate. dpplicationShouldTer minate: returns NO, control is returned to the
main event loop, and the application isn’t terminated. Otherwise, this method posts an
NSApplicationWillTerminateNotification to the default notification center. Don’t put final cleanup code in

your application’snain() function; it will never be executed. If cleanup is necessary, have the delegate
respond tapplicationWillTerminate: and perform the cleanup in that method.

Seealso: —run, —stop:, exit()

tryToPerform:with:
— (BOOL)tryToPerform:(SEL)aSd ector with: (id)anObject

Dispatches action messages. The receiver tries to perform the ra8ghentior using its inherited
NSResponder methadyToPerform:with:. If the receiver doesn't perforaselector, the delegate is given
the opportunity to perform it using its inherited NSObject methedfior m: withObject:. If either the
receiver or its delegate acceg®el ector, this method returns YES; otherwise it returns NO.

See also: —respondsT oSelector: (NSObject)

unhide:
— (void)unhide: (id)sender

Restores hidden windows to the screen and makes the application active. Invokes
unhideWithoutActivation.

See also: —activatelgnoringOther Apps:., —hide:



unhideWithoutActivation
— (void)unhideWithoutActivation
Restores hidden windows without activating their owner (the receiver). When this method begins, it posts

an NSApplicationWillUnhideNotification to the default notification center. If it completes successfully, it
posts an NSApplicationDidUnhideNotification.

See also: —activatelgnoringOther Apps., —applicationDidUnhide: (delegate method),
—applicationWillUnhide: (delegate method), kide:

updateWindows
— (void)updateWindows
Sends anmpdate message to each on-screen NSWindow. This method is invoked automatically in the main
event loop after each event. If the NSWindow has automatic updating turnedupalaits method will
redraw all of the NSWindow’s NSViews that need redrawing. If automatic updating is turned off, the

update message does nothing. (You turn automatic updating on and off by sestéintpdisplay: to an
NSWindow.)

When this method begins, it posts an NSApplicationWillUpdateNotification to the default notification
center. When it successfully completes, it posts an NSApplicationDidUpdateNatification.

See also: —applicationWillUpdate: (delegate method), applicationDidUpdate: (delegate method),
—satWindowsNeedUpdate:, —setAutodisplay: (NSWindow)

updateWindowsltem:
— (void)updateWindowsltem: (NSWindow *)aWindow

Updates the Window menu item faindow to reflect the edited status @afVindow. You rarely need to
invoke this method because it is invoked automatically when the edit status of an NSWindow is set.

See also: —changeWindowsltem:title:filename:, —setDocumentEdited: (NSWindow)

validRequestorForSendType:returnType:
— (id)validRequestor For SendType: (NSString *sendType retur nType: (NSString *returnType

Indicates whether the receiver can send and receive the specified pasteboafthiypesssage is sent to

all responders in a responder chain. NSApp is typically the last item in the responder chain, so it usually
only receives this message if none of the current responders caseehgbe data and accept back
returnType data.

23



Classes: NSApplication

The receiver passes this message on to its delegate if the delegate can respond (and isn’t an NSResponder
with its own next responder). If the delegate can’t respond or retilrribis method returnsil. If the

delegate can find an object that can seamdiType data and accept bac&urnType data, that object is

returned.

See also: —validRequestor For SendTypereturnType: (NSResponder),
—register ServicesM enuSendTypes.andRetur nTypes:,
—readSelectionFromPasteboard: (NSServicesRequests protocol),
—writeSelectionToPasteboard:types: (NSServicesRequests protocol)

& windowWwithwindowHandle:
— (NSWindow *windowWithWindowHandle: (void *)hWhnd

On Microsoft Windows platforms, returns the NSWindow object associated with the Win32 window handle
hwnd. If the application does not ovittwhd or hwhd does not have an NSWindow associated with it, this
method returngil. This method is for Microsoft Windows platforms onkindowWithwWindowHandle:

is not defined for the Mach platform.

See also: —windowWithWindowHandle (NSWindow), ~windowHandle (NSWindow)

windowWithWindowNumber:
— (NSWindow *WwindowWithWindowNumber : (int)windowNum

Returns the NSWindow object correspondingvindowNum.

windows
— (NSArray *windows

Returns an NSArray of the application’s NSWindows, including off-screen windows.

windowsMenu
— (NSMenu *windowsMenu

Returns the Window menu ail if no Window menu has been created.

See also;: —satWindowsM enu:
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Notifications
NSApplicationDidBecomeActiveNotification
Posted immediately after the application becomes active. The notification contains:
Notification Object NSApp

Userinfo None

NSApplicationDidFinishLaunchingNotification

Posted at the end of the finishL aunching method to indicate that the application has completed launching
and isready to run.

The notification contains:
Notification Object NSApp

Userinfo None

NSApplicationDidHideNotification
Posted at the end of the hide: method to indicate that the application is now hidden. The notification

contains:
Notification Object NSApp
Userinfo None

NSApplicationDidResignActiveNotification
Posted immediately after the application gives up its active status to another application. The notification

contains:
Notification Object NSApp
Userinfo None
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NSApplicationDidUnhideNotification

Posted at the end of the unhideWithoutActivation method to indicate that the application is now visible.
The notification contains:

Notification Object NSApp

Userinfo None

NSApplicationDidUpdateNotification

Posted at the end of the updateWindows method to indicate that the application has finished updating its
windows. The notification contains:

Notification Object NSApp

Userinfo None

NSApplicationWillBecomeActiveNotification
Posted immediately after the application becomes active. The notification contains:
Notification Object NSApp

Userinfo None

NSApplicationWillFinishLaunchingNotification

Posted at the start of the finishL aunching method to indicate that the application has completed its
initialization process and is about to finish launching. The notification contains:

Notification Object NSApp

Userinfo None

NSApplicationWillHideNotification

Posted at the start of the hide: method to indicate that the application is about to be hidden. The notification
contains:

Notification Object NSApp

Userinfo None



NSApplicationWillResignActiveNotification

Posted immediately before the application gives up its active status to another application. The notification
contains:

Notification Object NSApp

Userinfo None

NSApplicationWillTerminateNotification

Posted by the ter minate: method to indicate that the application will terminate. Posted only if the delegate
method applicationShouldTer minate: returns Y ES. The notification contains:

Notification Object NSApp

Userinfo None

NSApplicationWillUnhideNotification

Posted at the start of the unhideWithoutActivation method to indicate that the application is about to be
visible. The notification contains:

Notification Object NSApp

Userinfo None

NSApplicationWillUpdateNotification

Posted at the start of the updatéWindows method to indicate that the application is about to update its
windows. The notification contains:

Notification Object NSApp

Userinfo None

Methods Implemented By the Delegate

application:openFile:
— (BOOL)application: (NSApplication *theApplication openFile: (NSString *filename

Sent directly bytheApplication to the delegate. The method should open thédiffdeame, returning YES
if the file is successfully opened, and NO otherwise.
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Note: If the user has started up the application by double-clicking afile, the delegate receives the
application:openFile: message before receiving applicationDidFinishLaunching:.
(applicationWillFinishLaunching: is sent before application: openFile:.)

See also: — application:openFileWithoutUl:, —application:openTempFile;,
—applicationOpenUntitledFile:

application:openFileWithoutUI:
— (BOOL)application: (NSApplication *)sender openFileWithoutUl:(NSString *¥ilename

Sent directly bysender to the delegate to request that theffilename be opened as a linked file. The

method should open the file without bringing up its application’s user interface; that is, work with the file
is under programmatic control sénder, rather than under keyboard control of the user. Returns YES if the
file was successfully opened, NO otherwise.

See also: —application:openFile:, —appliction:openTempFile:, —application:printFile:,
—applicationOpenUntitledFile:

application:openTempFile:
— (BOOL)application:(NSApplication *theApplication openTempFile:(NSString *¥ilename

Sent directly bytheApplication to the delegate. The method should attempt to open tHddiiame,
returning YES if the file is successfully opened, and NO otherwise.

By design, a file opened through this method is assumed to be temporary; it's the application’s
responsibility to remove the file at the appropriate time.

See also: —application:openFile:, —application:openFileWithoutUI:, —applicationOpenUntitledFile:

application:printFile:
— (BOOL)application: (NSApplication *theApplication printFile:(NSString *¥ilename

Sent when the user starts up the application on the command line wiNSPrent option. Sent directly
by theApplication to the delegate.

The method should attempt to print the filename, returning YES if the file was successfully printed, and
NO otherwise. The application terminates (usingténeinate: method) after this method returns.

If at all possible, this method should print the file without displaying the user interface. For example, if you
pass theNSPrint option to the TextEdit application, TextEdit assumes you want to print the entire contents



of the specified file. However, if the application opens more complex documents, you may want to display
apanel that lets user choose exactly what they want to print.

See also: — application:openFileWithoutUI:

applicationDidBecomeActive:
— (void)applicationDidBecomeActive: (NSNotification *)aNotification
Sent by the default notification center immediately after the application becomesaidtitvication is

always an NSApplicationDidBecomeActiveNatification. You can retrieve the NSApplication object by
sending thevbject method taaNotification.

See also: —applicationDidFinishLaunching:, —applicationDidResignActive:,
—applicationWillBecomeActive:

applicationDidFinishLaunching:

— (void)applicationDidFinishL aunching: (NSNotification *)aNotification
Sent by the default notification center after the application has been launched and initialized but before it
has received its first evemiNotification is always an NSApplicationDidFinishLaunchingNaotification. You

can retrieve the NSApplication object in question by senoliject to aNaotification. The delegate can
implement this method to perform further initialization.

Note: If the user has started up the application by double-clicking a file, the delegate receives the
application:openFile: message before receiviagplicationDidFinishLaunching:.
(applicationWillFinishLaunching: is sent beforapplication:openFile:.)

See also: — applicationDidBecomeActive:, —applicationWillFinishLaunching:, —finishLaunching

applicationDidHide:
— (void)applicationDidHide: (NSNotification *)aNotification

Sent by the default notification center immediately after the application is hialdatification is always
an NSApplicationDidHideNatification. You can retrieve the NSApplication object in question by sending
object to aNotification.

See also: —applicationWillHide:, —applicationDidUnhide:, —hide:
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applicationDidResignActive:
— (void)applicationDidResignActive: (NSNatification *)aNotification

Sent by the default notification center immediately after the application is deactadtification is
always an NSApplicationDidResignActiveNoaotification. You can retrieve the NSApplication object in
guestion by sendingbject to aNatification.

See also: —applicationDidBecomeActive:, —applicationWillResignActive:

applicationDidUnhide
— (void)applicationDidUnhide: (NSNotification *)aNotification

Sent by the default notification center immediately after the application is made \ablbfigication is
always an NSApplicationDidUnhideNotification. You can retrieve the NSApplication object in question by
sendingobj ect to aNotification.

See also: —applicationDidHide:, —applicationWillUnhide:, —unhide:

applicationDidUpdate:
— (void)applicationDidUpdate: (NSNotification *)aNotification

Sent by the default notification center immediately after the NSApplication object updates its NSWindows.
aNatification is always an NSApplicationDidUpdateNotification. You can retrieve the NSApplication
object in question by sendirfject to aNotification.

See also: —applicationWillUpdate:, —updateWindows

applicationOpenUntitledFile:
— (BOOL)applicationOpenUntitledFile: (NSApplication *theApplication

Sent directly bytheApplication to the delegate to request that a new, untitled file be opened. Returns YES
if the file was successfully opened, NO otherwise.

See also: —application:openFile:, —application:openFileWithoutUl:, —application:openTempFile:



applicationShouldTerminate:
— (BOOL)applicationShouldTer minate: (NSApplication *)sender
Invoked from within théer minate: method immediately before the application terminatagler is the

NSApplication to be terminated. If this method returns NO, the application is not terminated, and control
returns to the main event loop. Return YES to allow the application to terminate.

See also: —applicationShouldTer minateAfter LastWindowClosed:, —applicationWill Ter minate:,
—terminate;

applicationShouldTerminateAfterLastWindowClosed:
— (BOOL)applicationShouldTer minateAfter LastWindowsClosed: (NSApplication *theApplication

Invoked when the user closes the last window that the application has open on.

This method is intended for the Microsoft Windows platform. On Microsoft Windows, the default behavior

is to terminate the application if the user closes the last window. Most application use this default behavior;
however, you may choose to hamplicationShouldTer minateAfter LastWindowClosed: perform

some other function, such as display a panel that gives the user a choice of exiting the application or opening
a new window.

If this method returns NO, the application is not terminated, and control returns to the main event loop.
Return YES to allow the application to terminate. Note a@paticationShouldTerminate: is invoked if
this method returns YES.

See also: —terminate

applicationWillBecomeActive:
— (void)applicationWillBecomeActive: (NSNotification *)aNotification

Sent by the default notification center immediately before the application becomesaddtdtification is
always an NSApplicationWillBecomeActiveNatification. You can retrieve the NSApplication object in
guestion by sendingbject to aNotification.

See also: —applicationDidBecomeActive:, —applicationWillFinishLaunching:,
—applicationWillResignActive:
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applicationWillFinishLaunching:
— (void)applicationWillFinishL aunching: (NSNotification *)aNotification

Sent by the default notification center immediately before the NSApplication object is initialized.
aNotification is always an NSApplicationWillFinishLaunchingNotification. You can retrieve the
NSApplication object in question by sendiolgj ect to aNotification.

See also: —applicationDidFinishLaunching:, —applicationWilBecomeActive:, —finishLaunching

applicationWillHide:
— (void)applicationWillHide: (NSNotification *)aNotification

Sent by the default notification center immediately after the application is higldetification is always
an NSApplicationWillHideNotification. You can retrieve the NSApplication object in question by sending
object to aNotification.

See also: —applicationDidHide:, —hide:

applicationWillTerminate:
— (void)applicationWillTer minate: (NSNotification *)aNotification

Sent by the default notification center immediately before the application termafddésication is
always an NSApplicationWillTerminateNotification. You can retrieve the NSApplication object in
guestion by sendingbject to aNatification. Put any necessary cleanup code in this method.

See also: —applicationShouldTerminate:, —ter minate:

applicationWillResignActive:
— (void)applicationWillResignActive: (NSNotification *)aNatification

Sent by the default notification center immediately after the application is deactadtification is
always an NSApplicationWillResignActiveNatification. You can retrieve the NSApplication object in
guestion by sendingbject to aNatification.

See also: —applicationWillBecomeActive:, —applicationDidResignActive:
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applicationWillUnhide
— (void)applicationWillUnhide: (NSNotification *)aNotification

Sent by the default notification center immediately after the application is unhaditiication is always
an NSApplicationWillUnhideNotification. You can retrieve the NSApplication object in question by
sendingobj ect to aNatification.

See also: —applicationDidUnhide:, —applicationWillHide:, —unhide:

applicationWillUpdate:
— (void)applicationWillUpdate: (NSNotification *)aNotification

Sent by the default notification center immediately before the NSApplication object updates its
NSWindows.aNotification is always an NSApplicationWillUpdateNotification. You can retrieve the
NSApplication object in question by sendiolgj ect to aNotification.

See also: —applicationDidUpdate:, — updatewWindows
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